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The last change in Inkscape 
version 1.3 that I’m going to 

cover in these articles is described 
as follows in the release notes: 
“The Filter Editor has been 
overhauled and is now easier to 
use!” Well, it’s definitely been 
overhauled. As to whether or not 
it’s easier to use… I’ll just describe 
the functionality and let you decide 
that for yourself.

I first covered the Filter Editor 
dialog back in part 48 of this series 
(FCM #108). I then spent a further 9 
issues detailing each of the 
individual filter primitives. Despite 
the overhaul in the Filter Editor’s 
UI, those details still mostly apply – 
so if you want to revise your filter 
knowledge, I suggest reading those 
articles as well. That first article 
described how to create a simple 
filter chain for a drop shadow 
effect so, at the risk of repeating 
myself over 100 issues later, I’m 
going to do the same with the new 
editor.

In practice, I recommend using 
the Filters > Shadows and Glows > 
Drop Shadow… dialog for creating 

drop shadows on a day-to-day basis. 
The end result is a slightly different 
filter chain to the one we’ll be 
creating here, but it’s a quicker, 
easier, and more flexible option for 
most purposes. However, with the 
knowledge gained from creating 
your own filter chain from scratch, 
it will be easier to tweak Inkscape’s 
built-in offerings via the Filter 
Editor dialog, should you need to.

A filter is applied to one or more 
objects, either individually or 
contained within a group. It’s 
important to understand the 
difference: when a filter is applied 
to a group, it’s as though the entire 
contents of the group is flattened 
down to a single object before the 
filter is applied. This image shows 
the same shapes with the same 
drop shadow applied, but the pair 
on the left are separate elements, 

whereas the pair on the right are 
grouped together, with the filter 
being applied to the group.

Of course you’re free to mix 
things up further, applying filters to 
objects before grouping them and 
adding another filter to the group 
itself, for example. Sometimes 
there are good reasons for creating 
such complex arrangements, but do 
bear in mind that filters come at a 
cost. They are calculated ‘live’, 
which gives you the advantage of 
being able to tweak their 
parameters later, but which can 
chew up computing power very 
easily once too many, or too 
complex, filters are applied to the 
drawing. For our simple drop 
shadow example, however, speed 
isn’t likely to be too much of a 
concern.

Since a filter is applied to an 
object or group, we’ll first need to 
create something. Following the 
example in my old article, I’m going 
to work on a bold and colorful text 
object. First a reminder of how the 
Filter Editor dialog was arranged in 
earlier versions of Inkscape.

And now the new layout, in 
version 1.3. There’s also an 
alternative layout which is 
automatically used if your dialog is 
wide enough, but, in my opinion, it 
puts the panels in the wrong order 
(the parameters for the selected 
primitive on the left, and the filter 
chain containing the list of 
primitives on the right – breaking 
the usual left-to-right flow of a 
parent-child relationship in the UI). 
Therefore, I’ll stick to the vertical 
layout in this article.
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Neither of these is particularly 
intuitive, but the old dialog at least 
had the benefit of a fairly large 
button labelled ‘New’ to hint at 
your starting point. The equivalent 
in the new design is the much 
smaller ‘+’ button towards the right 
of the top row of controls. Good 
luck if you’re using the symbolic 
icons, where this looks even less 
obviously like a button!

Clicking that ‘+’ button creates a 
new filter with an automatically 
generated name (‘filter1’ in this 
image), and activates a little more 
of the UI. The text on the bottom 
panel becomes slightly more 

helpful, telling us to add an effect 
from the search bar. The search bar 
in question is the drop-down with 
the magnifying glass icon and the 
‘Add effect’ placeholder text.

This search bar actually works in 
two different ways, which can be a 
little confusing at first. For most 
users, I recommend opening the 
pop-up by clicking the down-arrow 
at the right. The result is a 
categorised array of the filter 
primitives, each with a small icon 
that sort-of represents what it 
does. The icons aren’t always of 
much use in determining which 
primitive is which: the ones that I 
mix up the most (Blend, Merge and 
Composite) all share the same icon! 
But I find it’s useful to see all the 

primitives at once to help reassure 
myself that I’m picking the right 
one amongst all the options.

The second mode kicks in if you 
type into the field. This presents a 
vertical list of primitives, filtered by 
the text you type. If you absolutely 
know you want the Gaussian Blur 
primitive, for example, typing ‘blur’ 
or even just ‘ga’ will be enough to 
restrict the list to the one you want.

Whichever approach you take, 
select the Gaussian Blur primitive 
to add it to your filter chain. The 
main panel will now be updated to 
show the primitives in your chain 
(just the one, so far), while the 
bottom panel shows the 
parameters for that primitive.

Although the controls in this 
section will vary depending on the 
primitive, they all share the three 
icon buttons that are shown next to 
the name. Clicking the first opens a 
small pop-up, which contains some 
additional information about the 
primitive. The other two will 
duplicate or delete the primitive, 
respectively. In the older editor, 
these existed only on the context 
menu in the editor pane (where 
they can also still be found). It’s 
good that these have been more 
obviously surfaced in the UI, though 
my build does not show tooltips for 
either of them: although the icons 
make their function fairly obvious, 
it’s still reassuring to be able to see 
a textual representation of their 
purpose.

At this point, we have a valid 
filter chain, but our text still looks 
as un-blurred as ever. This was a 
shortcoming of the old editor as 
well, but it would have been nice if 
the new redesign had gone so far 
as to automatically associate the 
filter with the object we had 
selected when we created it. To 
make this association, we have to 
manually click the checkbox next to 
the word ‘Filter’ on the top line – 
and voila, we have blurred text.
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The old dialog showed a list of 
all the filters in the document on 
the left, with a checkbox to indicate 
which one applied to the selected 
object, and a count of the number 
of objects in the document which 
use that filter. Changing the name 
of a filter was done by double-
clicking on it to edit it in-place, and 
there was a context menu for 
duplicating and deleting filters.

 

The ‘Filter’ pop-up in the new 
dialog offers the same options, 
now with more obvious buttons 
(still with no tooltips though). 
Renaming just requires a single 

click on the filter name to enter 
editing mode, and the currently 
active filter is shown more correctly 
using radio buttons rather than 
checkboxes.

The ‘check’ or ‘tick’ button is 
worth drawing attention to 
specifically. The lack of a tooltip 
had me puzzling over its purpose, 
since it didn’t seem to assign the 
selected filter to the current 
objects as you might imagine from 
its visual association with the 
checkbox in the main dialog. What 
it actually does is the exact 
opposite: given a selected filter in 
the pop-up, it selects all the objects 
on the canvas that use the filter. 
This is a great addition that I’ve 
wanted for years, to aid with de-

duplication of filters in complex 
drawings – it’s just a shame that it’s 
got an ambiguous and nondescript 
icon with no tooltip.

At this point, you can rename 
your filter to something more 
descriptive (“Blur”, or “Drop 
shadow” as that’s where we’re 
going with it), and you can play 
around with the sliders in the 
bottom panel to adjust the amount 
of blur applied to the text.

Inkscape veterans may be 
wondering where the old ‘Filter 
General Settings’ tab has gone to. 
This is used to set the maximum 
size of the filter area, and 
sometimes has to be adjusted to 
stop filters being clipped. It now 
lives behind the cog icon at the 
right of the top row of controls, but 
can probably be left set to 
‘Automatic Region’ unless you have 
a specific clipping issue.

Also missing for old-timers are 

the various sources listed to the 
right of the main editing panel, 
with only ‘Source Graphic’ and 
‘Source Alpha’ being visible by 
default. The other options are still 
available, and can be toggled with 
the button next to the Search Bar. 
But to be honest, they’re either 
tricky to use or downright broken in 
Inkscape – and always have been. 
Much as I would love to see the 
underlying issues addressed to 
make these more useful, hiding 
them by default is definitely the 
best option for most users. In fact I 
would have gone a step further, and 
had the toggle button inside the 
‘cog’ pop-up, where it would be less 
likely to tempt unsuspecting users.

The actual details of creating a 
filter chain haven’t really changed, 
unfortunately. We’re still stuck with 
a list-based view of the filter 
primitives which feels restrictive 
and archaic compared with the 
‘node editor’ approach that is 
common for similar tools in other 
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products. There’s no technical 
limitation with SVG that prevents 
Inkscape having such a UI but it 
would be a huge undertaking – so 
unless some intrepid developer 
with lots of free time wants to give 
it a go, I think we’ll be looking at 
minor variations on this list for a 
long time to come.

Given that this part of the UI 
remains mostly the same, I’m going 
to rattle through the remaining 
steps of our drop-shadow filter 
quite quickly. See those older 
articles if you need a slower 
introduction.

For the basic sort of drop-
shadow we want, the shadow 
needs to be a blurred version of the 
object with a black fill, not the 
bright color we’re currently seeing. 
The classic answer to this, in filter 
terms, is to drag the handle from 
the triangle next to the Gaussian 
Blur filter, over to the right, 
dropping it on the Source Alpha 
column. That causes the input to 
our blur to be taken from the 
transparency of the object which, in 
practice, means that filled pixels in 
the source end up as black pixels in 
the alpha. It’s a quick way to turn 
our red blur into a black blur.

Since this blurred version will be 
the shadow, we need to move it 
from its original position. This is 
done by adding an Offset filter 
primitive to the chain by selecting it 
via the effect search bar. My brain 
always wants to click the ‘+’ button, 
but that adds a whole new filter, 
not just another primitive. 
Remember that in the new UI, the 
act of selecting the primitive also 
adds it – there’s no confirmatory 
step required. Compared with the 
old UI, this makes it impossible to 
read the info text about a primitive 
until after you’ve added it 
(furthering my confusion between 
Blend, Merge and Composite). At 
least there’s now a more obvious 
button to delete it when you realise 
you’ve picked the wrong one.

If the new primitive isn’t 
automatically linked to the one 
above, drag from the triangle on 
the Offset primitive up to the 
Gaussian Blur, then release the 
mouse button to create a visible 
connection. You can adjust the 
sliders for the Offset primitive to 
your taste. Remember that filters 
are ‘live’ and you can always re-
adjust them later, so don’t get hung 
up on guessing the right values 
now. On the canvas you should see 
your blurred, black text move 

around as you change these values.

The final step with a drop-
shadow is to put a copy of the 
original object back on top. This is 
most easily done with the Merge 
primitive, which literally just layers 
things on top of each other in the 
order in which they’re linked. Again, 
add it using the effect search bar. If 
it’s not automatically connected, 
drag from the triangle up to the 
Offset primitive. A second triangle 
will be created below the first, 
which you should drag to the 
Source Graphic column to the right. 
Basically we’ve just told it to merge 
together two images – the output 
from the Offset primitive on the 
bottom, overlaid by the original 
object on top. Our filter is 
complete.

In this image (top right) I’ve 
edited and resized the text, and 
edited the name of the filter itself, 
to give the final result – and a 
picture of what your filter chain 
should hopefully look like.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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Last month saw the end of my 
articles describing the updates 

in Inkscape 1.3.x, so, after 150 
months of bringing you all the 
gnarly details about every feature 
and corner of the application, I was 
looking forward to a few weeks off. 
No such luck. No sooner had I 
submitted the previous article 
about improvements to the Filters 
dialog, than version 1.4 was 
released. It doesn’t have as long a 
list of user-facing changes as some 
releases, though there has been a 
lot of work done under-the-hood to 
prepare for future development. 
Nevertheless, I plan to cover the 
new features in-depth, as usual – 
and perhaps this time I’ll get ahead 
of the developers enough to earn 
some time off!

As usual, the new release can be 
downloaded from the Inkscape 
website. It’ll probably take a little 
while to get into the repositories of 
most distros, but the website offers 
Linux users an AppImage version, 
and a PPA. I’ll be using the former 
simply because it’s easier for me, 
given that I have to keep a few 
older versions around as well for 

comparison purposes. If you’re 
using Ubuntu or another Debian-
based system, and want only a 
single Inkscape version installed, 
the PPA might be your best option. 
Installers are also available for 
Windows and MacOS.

https://inkscape.org/release/
inkscape-1.4/

In terms of describing the new 
features, I guess we may as well 
pick up where we left off: filters. 
Nothing has changed in terms of 
the filter editor dialog itself, 
though. The main Filter menu has 
been slightly rearranged to move 
the Filter Editor… entry towards 
the top of the layout, just below 
the new Filter Gallery… entry.

The Filter Gallery is one of the 
headlines of the 1.4 release, and is 
arguably long overdue. Back in the 
distant past, when this column first 
began, Inkscape didn’t come with 
any predefined filters. Whether you 
wanted a simple drop shadow or a 
more complex 3D lighting effect, 
you had no choice but to either 
create one from scratch using the 
filter editor, or to copy and paste an 
object which already had a suitable 
filter applied, from another 
document.

This copy-pasting approach was 
so useful that a number of users on 
websites and forums made SVG 
files available that contained 
nothing but copies of the same 
object with different filters applied 
to each. In this way you could see 
the filter as it appeared on a real 
object in order to get a preview of 
how it looked, before copying the 
object into your own document and 
then applying the freshly imported 
filter chain to your own elements.

Version 0.47 introduced the 
hierarchical menu of predefined 
filters that we have now, and I’m 

sure most readers head there first 
when they need to add a filter to an 
object (I certainly do!). It’s much 
easier to pick a filter from a 
categorised list that’s built into the 
software than it is to: hunt for a 
third party filter file; open it; select 
the filtered object; copy it into your 
own document; apply the filter to 
your target element; finally, delete 
the copied object.

But as convenient as a curated 
list of named filters may be, one 
thing that was sorely lacking 
compared to the old approach was 
the ability to see what effect the 
filter has on real content before 
you apply it. That’s what the new 
Filter Gallery brings to Inkscape. 
Select that option, and you’ll be 
presented with this dialog (next 
page, top middle).

To the left is a list of the filter 
categories, corresponding mostly 
to the sub-menus in the Filters 
menu. One difference is the 
addition of an ‘All filters’ category 
at the top. As you’ve probably 
guessed, selecting an option in this 
list will filter the previews shown at 

https://inkscape.org/release/inkscape-1.4/
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the right to only include those from 
the corresponding category. The 
‘All filters’ option does as its name 
suggests, and shows previews for 
all the available filters, regardless 
of category. Unfortunately the 
previews are still grouped by 
category in this mode, rather than 
appearing alphabetically by name, 
which doesn’t really make sense to 
me, especially as the groupings 
aren’t made clear with different 
background colours or badges on 
the previews.

The category list can be made 
wider or narrower by dragging the 
separator bar that sits between the 
list and the previews, though 
category names get truncated with 
an ellipsis in the middle rather than 
wrapping to multiple lines. The list 
panel can also be collapsed 
completely using the toggle button 
at the top-left of the dialog. There 
is a small bug, however, which 
makes this feature less useful than 
you might expect. Collapsing the 
list automatically switches to 
showing all the filter previews (as 
though you had the ‘All Filters’ 
category selected), which does 
make some sense. But if you click 
the toggle to expand the list again, 
it continues to show all previews, 
even if you have a specific category 

selected. Clicking the same, already 
selected, category does nothing. To 
kick it back into life you have to 
select a different category – after 
which you may re-select the original 
one, if you wish. It’s a small but 
annoying bug that reduces the 
utility of the collapse button 
significantly.

As well as selecting a category, 
the other way to reduce the 
number of previews that are shown 
is to use the filter field at the top-
right. This filters dynamically as you 
type, also taking the selected 
category into account. Therefore 
entering some text in here can only 
ever reduce the number of visible 
previews, it won’t increase the 

number by displaying entries from 
other categories that match the 
search. This is a shame, as it would 
be more useful for it to show 
matches from within the category 
first, but also show other matches 
below a dividing line. That would 
allow you to use it to quickly select 
a specific filter without having to 
change categories.

At the right of the dialog is the 
preview pane, showing each 
individual filter chain as a preview 
image with the filter name below it. 
The size of the thumbnails can be 
adjusted using the slider hidden 
behind the ‘gear’ button at the top 
of the dialog. Moving this slider 
causes the previews to update 

dynamically, which can take a short 
while if there are a lot of them 
visible. That, in turn, leads to a jerky 
and frustrating UI. A better 
approach is to first select a 
category with few entries – perhaps 
‘Image Effects’ or ‘Scatter’ – before 
adjusting the slider. This allows the 
UI to update far more smoothly, 
making it much easier to pick the 
preview size that best suits you.

Once you’ve found the filter you 
wish to use, click on its preview and 
then click the Apply button at the 
bottom of the dialog to apply it to 
your selected object(s). For some 
filters the button will actually say 
Apply… (i.e. with a trailing ellipsis). 
This indicates that a dialog will 
open allowing you to customise 
some parameters of the filter 
before actually applying it for real 
(using the Apply button in the 
second dialog). Unfortunately 
there’s no indication from the 
thumbnails which filters are 
customisable in this way. Of course 
they can all be customised using 
the Filter Editor dialog once they’ve 
been applied, but those with an 
ellipsis on the Apply button expose 
a curated subset of the most useful 
parameters, so I’d like to see them 
more obviously flagged.
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If you do use a filter with a 

secondary dialog, there are a 
couple of things to note: the first is 
that this dialog will have a ‘Live 
preview’ checkbox towards the 
bottom. Enabling this box allows 
you to see what the final filter will 
look like on your objects before 
clicking the Apply button, making it 
easy to bail out by clicking the Close 
button instead. It’s a shame this 
feature isn’t present on all filters, 
whether they expose specific 
parameters or not. The second 
thing to note is that clicking Apply 
in the second dialog won’t close it, 
so you’ll have to manually do this if 
you want it removed from your 
screen while you continue your 
work.

Be aware that each time you 
click the Apply button for a given 
object the filter chain is appended 
to any existing chain. This can be 
useful if, for example, you want to 
use a visual effect from the 
Materials category, then add a drop 
shadow to the result. But it also 
means that if you just want to go 
through the list previewing how 
each filter looks on your object, 
you’ll need to remember to press 
Ctrl-Z between each one to avoid 
them stacking up. If you do want to 
apply multiple filters, I recommend 

grouping your object(s), multiple 
times if needed, to apply one filter 
per grouping level. By applying a 
separate filter to each group, rather 
than appending multiple filter 
chains to a single object, it makes it 
much easier to remove or modify a 
single filter at a time later.

One limitation of the Filter 
Gallery is that there’s only a single 
preview image available. While the 
flowery shape that has been chosen 
does a good job of representing 
most filters, the thick lobes may not 
be representative of the object you 
wish to apply the filter to in your 
specific image. Text, for example, 
can vary wildly between thick slab-
serif fonts and wispy cursive styles – 
and the effect of a given filter can 
be markedly different between the 
two. It would be great for a future 
version of this dialog to offer a few 
different preview shapes, perhaps 
including an option to preview 
against some user-defined text in a 
font of your choice.

Although the selection of 
predefined filters supplied with 
Inkscape is quite comprehensive, 
there may be times when you need 
something different. Perhaps you 
have a house-style for a particular 
filter that you need to apply again 

and again across different 
documents – that’s certainly the 
case with the drop shadows I use on 
the speech bubbles in some of my 
comic strips, for example. While you 
can certainly just copy and paste a 
filtered object between files as a 
way to copy the filter chain itself, an 
alternative is to create a custom 
filter that is registered with 
Inkscape. Don’t worry, it’s easier 
than it sounds.

The first step is simply to create 
a filter chain that suits your needs. 
One way to do this is just to start 
with one of the predefined filters 
by applying it to an object in a file 
then tweaking the parameters via 
the Filter Editor dialog. 
Alternatively you can create an 
entire filter chain from scratch, as I 

described last month.

In fact, let’s use last month’s 
filter as an example: it’s a simple 
drop shadow which uses the 
object’s alpha to define the 
shadow, resulting in a dark shadow 
that can only ever be black (this is 
why Inkscape’s own Drop Shadow 
filter, with its various parameters 
and colour picker, is usually a better 
option). The filter chain we created 
last time looks like the image 
shown below.

Most importantly I’ve opened 
the ‘Filter’ popup at the top of the 
dialog and used it to rename the 
filter from the default ‘filter1’ to 
the more descriptive ‘Dark drop 
shadow’. This isn’t essential, but 
giving your filters sensible names 
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will make them a lot easier to 
identify when you come to use 
them. Save the file somewhere you 
can easily find later.

The next step is to open 
Inkscape’s ‘User config’ directory in 
your file manager. You may not 
know where this is kept, but you 
can find the path listed in the 
Inkscape Preferences dialog (Edit > 
Preferences) in the ‘System’ pane 
(shown below).

Rather usefully, Inkscape 
provides a button to open this 
directory via your file manager. 
Within that directory you should 
create a ‘filters’ folder, if there’s not 
one there already. Navigate into 
that directory, then copy the SVG 

file you saved earlier into it. Quit 
and restart Inkscape for it to pick up 
the new addition.

If all has gone according to plan 
you’ll now have a new ‘Personal’ 
entry in the Filters menu – and a 

corresponding new category in the 
Filter Gallery.

You can now easily select your 
filter and apply it to objects across 
all your Inkscape projects.

This feature can be extremely 
useful – but there’s also a bug that 
makes it rather annoying. If you’re 
the sort of person who uses this 
capability, it’s likely that you’ll also 
want to create multiple custom 
filters. That’s fine, just add them all 
to one file in that config directory 
and they’ll appear in the UI. Or add 
multiple files, with one filter in 
each, and they’ll equally appear in 
the UI. But if you add multiple files, 
each of which contains multiple 
filters, only the first one in each file 
will appear in the UI. This is a rather 
frustrating limitation which makes 
it harder to collect and share files 
filled with filters between different 
users. Remember: one file with 
multiple filters, or multiple files 
each with one filter. But not 
multiple files with multiple filters.

In a similar vein, there’s one final 
annoyance in the Filter Gallery I’d 
like to bring up: why doesn’t it have 
a category for the filters that are 
being used in the current 
document? I often need to use the 

same filters multiple times in a 
single document, and it would be 
useful to be able to preview and 
select them from the gallery UI in 
the same way as custom filters I’ve 
saved into the config directory.

But those small issues aside, this 
dialog is a great addition to 
Inkscape, and one that’s long 
overdue. Hopefully we’ll get the 
option for different preview images 
in future, and some of the small UI 
bugs and issues will be ironed out, 
but even as it stands it’s still very 
useful for those of us who like to 
add a little bitmap magic to those 
otherwise too-clean vector images.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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If you’ve already downloaded 
Inkscape 1.4 (you have, haven’t 

you?), then you may have had a 
glance through the release 
announcement and concluded that 
not a huge amount has been added 
or changed in this release. While it’s 
true that a lot of the development 
work in 1.4 has focused on the 
internals of the program, in 
preparation for a future migration 
to the GTK4 toolkit, there have also 
been a lot of smaller changes that 
didn’t necessarily make it into the 
release announcement – and which 
will keep this column populated for 
a while. Of course, I’ll be covering 
the big headline changes, but this 
month I’m going to cover a few of 
these smaller changes that are 
likely to be overlooked by other 
sources of Inkscape info.

NEW GUIDE LOCK STATE

The first change is an attempt to 
address a genuine user experience 
issue with guides, but personally I 
think it has potentially introduced 
more problems than it solves. I’ll 
begin by explaining the scenarios in 
which this problem occurs, then 

describe the old and new 
behaviours.

Guides are a very handy tool in 
Inkscape. For those unfamiliar with 
them, they’re lines that are drawn 
above all other content in Inkscape, 
but which do not appear in an 
exported bitmap, or if the SVG file 
is loaded into another program. 
They’re purely an aid to help you 
align and position items in your 
document, and are often used as 
snap targets. Creating a guide is as 
simple as clicking and dragging 
from the ruler at the top or side of 
the canvas – a guide line will follow 
the mouse as you move it into the 
window, and then be placed where 
you release the mouse. If you drag 
down from the top ruler, you’ll 
generally get a horizontal guide. If 
you drag across from the left ruler 
you’ll generally get a vertical guide. 
I say “generally” because if you drag 
from the extreme ends of either 
ruler, you’ll get a guide at a 45° 
angle.

There are other ways to create 
guides – such as creating them 
from a shape you’ve drawn using 

Object > Object to Guides – but the 
usual drag-from-ruler approach is 
all we need to concern ourselves 
with right now.

Double-clicking on any guide 
opens a dialog that allows you to 
position them precisely, or move 
them a relative amount, as well as 
change their color, angle, and label.

Using this dialog, you can also 
lock a guide to prevent it being 
accidentally moved… but it’s here 
that the UX problems begin. A 
guide can be in one of three states: 
locked, normal and hovered (when 
the mouse hovers over an unlocked 
guide). The scaled-up image below 
shows these three states – note 
that the locked state has a small 
cross as its handle, while a hovered 
guide changes color.

The problem is that, once 
locked, a guide can’t be modified at 
all. Moving the mouse over it 
doesn’t change the color to indicate 
the hovered state, you can’t drag it 
to a different location, and you 
can’t double-click on it to re-open 
the guide’s properties dialog. In 
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case you were wondering, the 
handle is equally immune to 
interaction.

To my mind, this is overkill. In 
almost every scenario I can think of, 
a user would want a locked guide to 
ignore any accidental attempts to 
move it to a different location. But 
they absolutely would want a way 
to open the properties dialog to 
change its color, delete it, or 
reposition it using the numeric 
input fields. Most notably, without 
access to this dialog there’s not 
really a way to unlock an individual 
guide once you’ve locked it. 
Preventing dragging of the guide, 
but still allowing access to the 
dialog by double-clicking on the line 
itself, or at least on the handle, 
would have been a sensible 
solution, but no version of Inkscape 
allows this.

There are ways to unlock or 
delete locked guides, but they are 
broad and excessive for most use 
cases. In the Edit menu, you’ll find a 
“Delete All Guides” option. This 
does exactly what it says, and 
immediately deletes all guides, 
whether locked or not. It’s 
obviously not very useful if you 
want to remove only a single guide.

Just above it in the menu, 
however, is an entry with a 
checkbox next to it, labelled as 
“Lock All Guides”. If any guides exist 
that are not locked, the checkbox 
will be clear and selecting this entry 
will lock all of the guides in the 
document. If every guide is already 
locked, the checkbox will have a tick 
in it, and selecting this will unlock 
all of them. Yes, every single one – 
even the ones you wanted to keep 
locked.

There is also an easily 
overlooked button at the top left of 
the canvas which not only reflects 
the state of that checkbox, but 
which can be clicked to lock or 
unlock all the guides without having 
to select the menu entry. Here you 
can see that the padlock icon is 
shown as open on the left, when 
not all of the guides are locked; 
clicking on the button locks all of 
them and changes the icon, as 
shown on the right. Note, however, 
that manually locking all the guides 
using their corresponding 

properties dialog does not change 
this icon to its locked state.

This button, or the menu entry, 
are the only ways (other than the 
XML Editor) to unlock a guide. But 
much like the delete option, it’s a 
broad brush that will unlock every 
guide, even if you need to adjust 
only one of them.

This is where the second UX faux 
pas kicks in – the one that has been 
“fixed” in version 1.4. Let us 
suppose that you’ve set up some 
useful guides, perhaps for page 
margins or columns. You don’t want 
to accidentally move them around, 
so you click the button to lock them 
all. Later you decide to add a guide 
to help you with the design of your 
image. It’s just a temporary thing to 
aid with alignment, so you drag it 
roughly into place, planning to 
open the properties dialog and 
adjust it to a specific position. In 
older versions of Inkscape, dragging 
out a new guide while the global 
lock is enabled would create a guide 
that was already in the locked state. 
If you didn’t drop it in exactly the 
right location, or if you wanted to 
make any other changes to it, you 
would need to unlock all the guides 
in order to be able to access its 
properties dialog. That means 

unlocking all the page layout guides 
as well, even though you really 
want them to remain locked.

But Inkscape 1.4 fixes this 
problem! Hurrah! Right?

Wrong. The “fix” that has been 
implemented is simply that 
dragging out a new guide will 
automatically unlock all the guides 
for you. Sure, it saves a click or two, 
but it also means that those page 
layout guides get automatically 
unlocked – except this time it may 
not be so obvious to a novice user 
until they accidentally move them. 
To aid in the discovery of this new 
feature, the lock button flashes 
briefly when you drag out a new 
guide. But at that point, your focus 
is likely to be on your new guide, 
not some small button at the 
corner of the canvas that you’ve 
probably never really noticed 
before.

This change was created by a 
new contributor to Inkscape, and I 
don’t want to be too harsh on them 
for attempting to do something 
about the problem of guides being 
created in a locked state. On the 
contrary, I absolutely applaud them 
for getting involved with Inkscape 
development, and I hope they 
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continue with their contributions. In 
reducing the number of clicks that a 
user might need to make, this does 
actually improve the situation for 
many users – it’s just that I feel it’s a 
band-aid instead of the much larger 
change that is actually required.

In my opinion, Inkscape needs a 
separate Guides dialog. Not the 
existing properties dialog that 
shows the details of only one guide 
at a time, but rather a dialog that 
lists all the guides in the document, 
and allows their properties to be 
changed individually. With such a 
dialog, it would be trivial to unlock 
a single guide at a time. But it 
would also make it possible to 
change the color, position or other 
properties of an individual guide 
without unlocking it first. The Lock 
All and Delete All options could be 
subsumed into the dialog, reducing 
the number of entries in the Edit 
menu as well. And when a new 
guide is dragged onto the canvas, it 
could simply be created in an 
unlocked state, without affecting 
the status of all the other guides. It 
sounds straightforward, but it 
would require a significant amount 
of work. Personally, I think the user 
experience benefits would make it 
worth the effort, but then I’m not 
an Inkscape developer.

PEN SEGMENTS TO GUIDES

The next small addition is also 
related to guide creation. A new 
command has been added to the 
Pen tool (aka Bézier tool) which will 
convert the currently drawn shape 
to guides. There’s no UI for this 
command, but it has been added to 
the list of keyboard shortcuts, albeit 
without any binding by default. To 
enable this, you therefore have to 
set the shortcut you wish to use: 
open the Inkscape preferences 
dialog (Edit > Preferences), select 
the Interface > Keyboard pane, then 
expand the Tool section in the 
shortcuts list, or just search for “Pen 
Segments to Guides”. Click in the 
“Shortcut” column (the content 
should change to “New 
Accelerator…”), then press your 
desired shortcut combination. I 
chose Alt-Shift-G, which was the 
only “G” combination that didn’t 
elicit a complaint that it was already 
assigned.

Once you’ve set a shortcut, use 
the Pen tool to draw a shape, then 
press your key combination to 
convert it to guides. The cynic in me 
would like to point out, however, 
that in my testing, the behavior was 

exactly the same as when a path is 
selected and Object > Objects to 
Guides is used. That menu entry 
also comes with a default shortcut 
of Shift-G already set. Unless I’m 
missing something, I can’t really see 
any benefit in having (and 
remembering) a special Pen tool 
specific shortcut rather than just 
using the more generic option.

CREATING PERFECT 
SQUARES

Having complained about the UX 
of one feature, and questioned the 
entire point of another, I feel the 
need to redeem this column with a 
genuinely useful addition. When 
using the Rectangle or Ellipse tool, 
it’s always been possible to force 
the resultant shape to an integer 
ratio (and also the “golden ratio” of 
1:1.618) by holding the Ctrl-key as 
you drag out your shape. The status 
bar even tells you what ratio it’s 
constrained to as you do so – a nice 
touch that many users have 
probably never even noticed. By 
moving close to a 45° angle from 
your starting point you can keep 
the ratio at 1:1 in order to create 
perfect squares or circles.

With the Ellipse tool, there was 

an additional option. Hold Ctrl-Alt 
and you would always create a 
circle – albeit one whose 
circumference passes through your 
original starting point. This is useful 
for creating circumscribing circles, 
whereas the behavior without the 
Alt key is more suited to inscribed 
circles. Nevertheless, a side-effect 
of this is that the Ellipse tool had a 
means of always creating a perfect 
circle, without the requirement to 
drag the mouse close to 45°.

With 1.4, this same Ctrl-Alt 
shortcut does something similar for 
squares. The drawn object doesn’t 
rotate around the starting point in 
the same way as when drawing a 
circle, but it does flip to one of the 
four quadrants depending on the 
mouse position. Too many novice 
users have struggled with the 
seemingly basic task of drawing a 
perfect square, and while there are 
several different ways to achieve 
this with Inkscape, this keyboard 
shortcut is perhaps the easiest to 
explain.

ARROW KEYS ON A ROTATED 
CANVAS

Do you sometimes rotate the 
canvas while working? Do you also 
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move objects or nodes using the 
arrow keys? If your expectation is 
that the arrow keys should move 
things horizontally and vertically, 
regardless of the rotation of the 
canvas, then you’re in luck, as this is 
now the default behavior for 
Inkscape 1.4. If, however, you prefer 
the movement to remain relative to 
the canvas rotation, you can switch 
back to this behavior by unchecking 
the “Arrow keys move object 
relative to screen” option in the 
Behaviour > Steps pane of the 
Inkscape preferences dialog (Edit > 
Preferences). It’s a shame there’s 
not a keyboard shortcut to toggle 
this option, as I can see that both 
approaches could have their merits, 
even when working with a single 
document.

BEHAVIOR WHEN DELETING 
NODES

The final small change I’ll 
mention this month will be good 
news for anyone who didn’t like the 
change in 1.3 to the behaviour of 
the Node tool (F2) when deleting 
nodes. Prior to that version, when 
deleting a node using the Del key, 
Inkscape would try to preserve the 
general shape of the path, even if 
that meant moving the handles of 
adjacent nodes around. With 
version 1.3, a degree of 
autodetection was added which 
would sometimes move handles 
and sometimes not, depending on 
the sharpness of the corner. 

Generally I think it does a 
reasonable job, but if you prefer the 
old behavior, you can now switch 
back to it by unchecking the 
“Deleting node preserves shape” 
option in the Tools > Node Tool 
pane of the Edit > Preferences 
dialog.

It’s also worth noting that the 
Ctrl-Del shortcut will delete the 
node and force the segment to be a 
straight line, regardless of the state 
of this checkbox – as has always 
been the case throughout all 

versions of Inkscape.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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Last month, I covered some of 
the smaller, less well publicized, 

changes and additions in Inkscape 
1.4. Let’s have more of the same 
this month…

SPRAY TOOL

To be honest, the Spray Tool 
(Shift-F3 or ‘A’) is one that I very 
rarely use. I covered it in depth 
more than a decade ago, back in 
part 26 of this series (FCM #86), 
and the base functionality has 
changed little since then. It has 
acquired a few extra controls over 
the years, and the developers have 
even sneaked in some extra toolbar 
buttons with version 1.4 which 
aren’t mentioned in any of the 
release documentation I’ve seen. 
Some further experimentation will 
be required so that I can dedicate a 
future article to all the capabilities 
this tool now has.

For the time being, however, I’m 
only going to look at a couple of 
seemingly small changes in 1.4 
which, in my opinion, greatly 
extend the utility of this tool. With 
these tweaks, the spray tool not 

only serves its main purpose of… 
well… spraying, but it also becomes 
a useful multi-stamping tool.

“Stamping” in Inkscape refers to 
a way of pasting multiple copies of 
an object, one-by-one. You simply 
drag the object in question around 
the canvas, and each time you press 
the spacebar, a copy is pasted at 
that location. If you need to quickly 
create a few copies of an object, it’s 
more efficient than repeatedly 
reaching for Ctrl-V then having to 
place the item in the required 
location. With snapping enabled, it 
makes for an extremely fast way to 
precisely place copies on your 
drawing. Version 1.3 introduced a 
variation on this theme whereby 
pressing the ‘C’ key, rather than the 
spacebar, will ‘stamp’ a clone rather 
than a copy.

The Spray Tool now offers a 
similar feature: select an object, but 
rather than ‘spraying’ it by clicking 
and holding the mouse button as 
you move the mouse around, a 
single click-and-release of the 
button will paste one copy of the 
object (or a clone, depending on 

the tool’s settings). Creating just a 
single copy or clone with a click isn’t 
new in itself, but there have been 
two changes in 1.4 that make this 
feature more useful: items created 
in this way are now placed at the 
center of the spray area, and the 
cursor shows a preview outline of 
the object before it’s created. 
These changes mean that you know 
exactly where your new object will 
be created, and the use of an 
outline may make this even better 
than the spacebar method in 
situations where the object might 
otherwise obscure the thing you’re 
trying to align it with.

This image shows a small purple 
star selected at the top-right. Next 
to it are two copies that have been 
created with single clicks, plus the 
cursor – complete with outline 
version of the star – positioned 
ready to create a third. Below, on 
the other hand, is the result of click-
dragging on the canvas, without 
changing any parameters. Stamping 
and spraying with the same tool, 
depending on when you release the 
mouse button.

But I said it had become a multi-
spray tool, so where’s the “multi” 
part? That kicks in when you have 
more than one item selected. This 
time I have three different objects 
selected, and you can see the 
cacophonous result of spraying 
those items below.

Stamping with single clicks 
brings more order to the chaos, but 
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the choice of which objects gets 
stamped is still somewhat random 
for each click.

There is now, however, a way to 
cheat the system and stamp only 
the specific object you want at each 
location. By holding the right 
mouse button down while moving 
the mouse just a little bit, the spray 
tool will switch between your 
selected objects – indicated by the 
outline preview changing. It does 
sometimes take a couple of tries 
before it switches to the object you 
want, but with a little patience you 
can tame the randomness of the 
selection in order to create just the 
objects you want at each location, 
as you can see in this image, 
created in this way.

Whether this is actually any 
more efficient than stamping each 

of the shapes separately with the 
spacebar will depend on your 
specific drawing and requirements, 

but it’s always good to have more 
options available.

SNAPPING PREFERENCES

While you’re busy stamping new 
copies or clones with the Spray 
Tool, it’s likely that you’ll want to 
enable snapping to make sure they 
land where you want. In that case 
(or in any other where you use 
snapping), you might be interested 
in the new options that have been 
added to the Edit > Preferences 
dialog, in the Behaviour > Snapping 

pane.

Have you ever been trying to 
snap to a grid or guide, only to find 
the cursor wants to snap to a 
nearby object instead? If so, these 
new controls are just what you 
need. If that’s something that’s 
never bothered you, however, you 
can leave them all unchecked to 
stick with the normal behaviour of 
snapping to any valid nearby target.

Enabling the first two options 
causes Inkscape to snap only to 
grids or guides (or both), if they are 
visible. The last part of that 
sentence makes these options 
much more powerful than they first 
appear. If you’ve toggled the grid 
off (with the ‘#’ key), then “Always 
snap to grids” has no effect. 
Similarly, toggling off the guides 
(using Shift-| – that’s the “pipe” key) 
will render the “Always snap to 
guides” option inert.

Let’s have a more practical 
example using just a grid (though 
the same principle applies to 
guides). With a grid enabled in older 
versions of Inkscape, the cursor 
would snap to the grid intersections 
and to the object nodes, bounding 
boxes, and so-on – depending on 
what snapping options you have 
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enabled. With “Always snap to 
grids” enabled, Inkscape will snap 
only to the grid intersections, 
regardless of whether any other 
snap targets are nearby. Hide the 
grid (‘#’) and the other snap targets 
kick in again, making it easy to 
constrain most of your work to the 
grid, but flip back to object 
snapping when needed.

The second set of checkboxes 
act as an override to the previous 
description. Suppose you want to 
always allow object snapping, even 
when you’ve otherwise constrained 
everything to snap to the grid? 
Enable the “Allow snapping to 
objects” checkbox in the 
preferences and object snap points 
will be considered as well as the 
grid.

(In case you’re wondering, 
“alignment snapping” and 
“distribution snapping” refers to 
the lines that appear to help you 
automatically align objects to 
existing things in your drawing, or 
space them evenly apart)

This whole snapping hierarchy is 
a little tricky to explain, so I’ll give 
you some rough rules-of-thumb to 
work by:

1/ If you’re happy with the way 
snapping works currently, don’t 
change anything. This should 
probably be the case for most 
users.

2/ If you get frustrated when 
Inkscape snaps to objects rather 
than your grid or guides, enable the 
relevant checkbox(es) in the first 
section and see if it improves 
matters. Toggle the visibility of the 
grid or guides when you need to 
snap to something else.

3/ If you generally like the 
behaviour with the first 
checkbox(es) enabled, but still want 
to snap to objects, or to have the 
align or distribute lines show up, 
enable the relevant checkbox(es) in 
the second section and see if it 
improves things for you. Once 
again, toggling the visibility of the 
grid or guides will switch back to 
using the “normal” snapping 
targets.

I don’t really think this is the best 
way to handle the hierarchy of 
which snap targets should take 
precedence, as it’s very difficult to 
conceptualise (and explain!) exactly 
how this works. But as someone 
who has occasionally tried to 
wrestle with a grid-based design 

while swearing at misplaced 
snapping points, I appreciate the 
attempt to try to do something to 
improve the situation.

KEYBOARD SHORTCUTS

A few more keyboard shortcuts 
are now customizable via Edit > 
Preferences, in the Interface > 
Keyboard pane. If you wish to 
change any of these, the easiest 
thing to do is to search for part of 
their name. To that end, here’s a 
table of the newly available 

shortcuts, together with their 
default values (see table above)

In addition to these, a few 
existing features that previously did 
not have a keyboard shortcut by 
default now do. Note that this 
applies only to new installations of 
Inkscape, and you’ll need to set 
them yourself on an existing 
installation. For these purposes, 
running the AppImage version acts 
as a new installation. The same may 
also apply to other “containerized” 
package formats that come from 
third-party sources (such as your 
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distribution’s repositories).

Note that in my AppImage copy 
of 1.4, all of these were set except 
the Inverse Clip shortcut. I’m not 
sure if the release notes are wrong 
or the AppImage config is incorrect, 
but if you use this feature a lot, it 
might be worth checking – and 
setting this shortcut if necessary.

ALIGN & DISTRIBUTE DIALOG

There’s been an attempt at a 
small, but welcome, quality-of-life 
improvement to the Align & 
Distribute dialog – except that it 
doesn’t work terribly well for me. 
This dialog can be used to align 
objects to each other, but also to 
align objects to the page or the 
drawing – the latter being the 
bounding box of all the objects on 
the canvas, whether they’re inside 
the page or not. When only a single 
object is selected, only the Page 
and Drawing options make sense… 
so Inkscape now limits the “Relative 
to” popup menu to show only those 
items (defaulting to Page). Select 
multiple items and the full list 
becomes available again.

This will work well for users who 
keep the dialog open all the time in 

a sidebar. For people like me, who 
prefer to open and close floating 
dialog windows as necessary, it 
doesn’t work so well. When the 
dialog is open, selecting a single 
object changes the popup as 
expected. But if a single object is 
selected first, and then the dialog is 
opened afterwards, it still shows 
the full list. It probably requires only 
a small fix to check the selected 
count when opening the dialog, but 
it’s a shame that it slipped through 
the cracks. I guess it confirms my 
suspicion that I’m in the minority as 
an old-school user who prefers 
dialogs in windows rather than 
permanently docked to the side of 
the window.

Next time I’ll cover a final 
selection of smaller changes that 
may have passed you by, before 
digging into some of the larger 
changes to 1.4 over the coming 
months. And if I manage to get 
through all those before the next 
major release, I guess I’ve now got 
the Spray Tool to revisit in more 
depth!

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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This month, I’ll be covering some 
more of the smaller additions 

and alterations in Inkscape version 
1.4, starting with a change that will 
affect your use of the program with 
all but the simplest of drawings.

CREATING LAYERS

The Layers and Objects dialog is 
a result of merging two formerly 
separate dialogs into one, and 
makes a lot of sense from the 
perspective of a user. But still 
hanging around from the days of a 
separate Layers dialog is the 
interstitial dialog that appears 
when creating a new layer – the one 
that lets you name the new layer, 
and select where in the hierarchy it 
will appear relative to the current 
layer. Here’s how it appeared in 
every version up to 1.3.2.

The big change for most users is 
that this dialog has both 
disappeared and been re-designed. 
Before you get too confused, what I 
mean is that it still exists, in a re-
designed form, but it’s been 
removed from the way it was most 
commonly accessed.

I’ll wager that most users 
manage their layers via the Layers 
and Objects dialog, using the 
buttons at the top to add and 
delete layers, and perhaps to shift 
them up and down in the hierarchy. 
In older versions of Inkscape, the 
“+” button would open this 
interstitial dialog, but no more. 
Now, clicking on that button (which 
doesn’t even have a tooltip on my 
copy of the program) will 
immediately create a new layer 
above the currently selected one.

Obviously this results in a loss of 
control over the name and position 
of the new layer, but it’s easy to 
rename the newly created layer by 
double-clicking on it, and it can be 
moved in the hierarchy by a drag-
and-drop operation. If all you want 
to do is to move it up and down the 

list, you can use the arrow buttons 
at the top, but Inkscape strangely 
lacks left and right buttons for 
turning into a sub-layer, or 
promoting it back to a higher level 
layer. For those latter operations 
you have to use drag-and-drop.

If you still prefer to use the old 
dialog, then there are two ways to 
access it: from the Layer > Add 
Layer… menu, or using the Ctrl-
Shift-N keyboard shortcut. 
Unfortunately, there’s no setting or 
other way to make the “+” button in 
the Layers and Objects dialog open 
this dialog as it used to, which is 
something of a shame for those 
that prefer to use this approach.

As mentioned above, the dialog 
has been slightly re-designed. 
Nothing major – just replacing the 
previous pop-up menu with 
separate radio buttons. I can see 
what the developers are trying to 
achieve with this layout, with the 
second option indented to suggest 
a sublayer – but it does look a bit 
untidy. I’d have perhaps left the 
radio buttons aligned, but indented 
the text or prefixed it with a line or 

arrow. Still, it’s one less click to 
change from the default placement 
than with the older version, which is 
an improvement.

I have mixed feelings about the 
change to the “+” button. In cases 
where layers are temporary, or not 
important enough to be explicitly 
named, it can make for a faster 
workflow. In other cases, splitting 
the creation, naming and 
placement into three steps will 
make things slower. Given that the 
Layers dialog already has an 
‘options’ section, would it have 
been so hard to add a setting to let 
the user choose their preferred 
mode of operation? Or at least 
allow a Shift-click on the button to 
open the old dialog still.
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TEMPLATES

A couple of new templates have 
been added to the File > New from 
Template… dialog. They’re named 
“Zine Booklet (US)” and “Zine 
Booklet (A4)”, and they’re the result 
of developer Martin Owen’s 
daughter’s interest in creating 
“zines” with her friends.

To some (older) people – such as 
myself – the word “Zine” conjures 
up thoughts of small run, counter-
culture publications, often centred 
around specific bands or hobbies. 
Zine is short for “magazine”, which 
makes a lot of sense given that 
these tended to be both physically 

smaller and with a lower page count 
than the usual news-stand fare.

Perhaps taking their inspiration 
from those earlier zines, the 
templates in Inkscape are a quick-
and-easy way to create a small 8-
page booklet from a single sheet of 
paper, with just a single cut and a 
little folding. The two variants are 
to accommodate a starting sheet of 
either US Letter size (11" × 8.5") or 
DIN A4 size (297mm × 210mm). In 
either case, the resultant zine is 
1/8th the size of the starting page – 
so A6 in the DIN system, and… 
well… I guess you’d need to do the 
math for the American version as I 
don’t believe it’s an officially named 

size.

On selecting either of these 
templates, you’ll be presented with 
a layout something like this (you 
may need to zoom out in Inkscape 
to see it all at once):

There seems to be a lot going on 
there, but it’s actually pretty 
straightforward. The pages in a row 
at the top are the ones you work 
on. Put your content there, making 
sure to remain within the page 
boundaries, or clip content which 
overspills the left and right sides. If 
you don’t, nothing will break, but 
you may end up with parts of one 
page appearing on another 
unintentionally.

The first pair of pages are used 
for the back and front covers of the 
zine in that order. Bear that in mind, 
because it’s easy to start with the 
design of your front cover and 
automatically think it needs to be 
put on the first available page. The 
subsequent pairs of pages are the 
insides of the zine, in the expected 
order.

As you add things to the pages 
you’ll see it automatically reflected 
in the 8-page layout at the bottom – 
with the content of pages 1-4 

flipped vertically. And yes, you can 
remove the preset labels in the 
middle of each page – they’re just 
there as guides to make the final 
layout a little more obvious when 
you first open this template.

With your content complete, 
here comes the very important part 
(which could really do with some 
explanation on the template itself): 
you want to print only the single 
composite page from the bottom 
of the template – the one labelled 
as “Print Sheet”. The easiest way to 
do this, if you’re printing from 
within Inkscape, is to switch to the 
Pages tool and click inside the Print 
Sheet section so that it’s selected. 
Then you can set the print range to 
“Current Page” in the print dialog.

Alternatively, you may wish to 
export the zine for printing from 
another program or on another 
computer. Select the File > Export 
menu entry, then in the dialog, 
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ensure that the Page button is 
active. That should show a list of all 
the pages in the template – select 
only the “Print Sheet” option 
before exporting to your preferred 
format.

Once the page is printed you 
need to fold it into eight. First, 
make a long mountain fold along 
the length of the page, folding it in 
half to form a long thin shape with 
pages 1-4 on one side and the 
remaining pages on the other. 
Open it back out before continuing. 
Now fold it in half along the width 
with a mountain fold, so that you 
have pages 3-6 on one side, and the 
rest on the other. With it still in half, 
fold each side back on itself with 
another “valley” fold so that you 
end up with a small concertina of 
paper with the printed content on 
the insides. Open it out a little so 
that you can get some scissors into 
the doubled-up section in the 
middle.

Now comes the cut. This is 
shown as a dotted line on the 
template, and is easily done with a 
single scissor cut from the folded 
edge down to the valley folds. You 
should now be able to easily fold 
the zine as shown on the image in 
the template to produce an 8-page 

booklet. Trust me, it’s easier than it 
sounds.

I really like this addition to the 
program. It’s a simple thing that can 
make for such a fun way to 
introduce kids to the idea of graphic 
design, publishing, and Inkscape 
itself.

IMPORT/EXPORT

There has been a small but 
useful change to the File > Export… 
dialog: if you enter a path for the 
export that does not exist on your 
filesystem, Inkscape will try to 
create the missing folder hierarchy, 
rather than showing a warning. I 
suspect that most people choose a 
path using the file selector, in which 
case this probably won’t ever kick in 
(since the file selector shows you 
only paths that already exist). But 

consider the use case of picking a 
base path with the file selector, 
then manually adding the name of a 
subdirectory for your export into 
the field in the dialog. This will now 
do the right thing, and use the 
subdirectory if it already exists, or 
create it for you if it doesn’t. Just 
watch out for typos (and case-
sensitive filesystems), or you might 
end up ‘losing’ files to locations you 
didn’t intend!

A new import filter has been 
added for Affinity Designer files 
(*.afdesign). Affinity’s programs are 
a common alternative to Adobe’s 
Creative Suite, for those people 
who want a commercially 
supported product, but prefer a 
more traditional software licence 
rather than the subscription model 
that Adobe enforces now. 
Therefore it’s great to see support 
added to Inkscape but, as is so 
often the case, the format is not 
officially documented, so there are 
likely to be gaps and bugs in the 
importer. If you have access to 
*.afdesign files and find there are 
problems with importing any of 
them, please do file issues via 
https://inkscape.org/report so that 
the filter can be improved further.

An old import filter sees a return 

with version 1.4. The CGM 
(Computer Graphics Metafile) 
importer was removed in version 
1.0, but has been reinstated now. 
This is an old format, but it’s an ISO 
standard so might be useful for 
interoperability with some other 
software or when dealing with 
archival material.

Finally, the PDF exporter now 
supports internal links between 
sections within the same file. See 
the Full Circle Magazine contents 
page as an example, whereby 
clicking on an entry jumps to the 
relevant page in the PDF. This is a 
really great addition that will 
greatly enhance Inkscape’s 
capabilities as a PDF authoring tool.

That’s all for the smaller, little 
publicized additions and fixes that 
I’ll be covering. Next month, I’ll 
start to look at some of the bigger 
headline changes that arrived with 
Inkscape 1.4.

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
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Over a decade ago, way back in 
2014, one of these articles 

covered the use of clipping paths to 
efficiently use several parts of a 
single bitmap image in a design, 
without the overhead of including 
multiple copies of the file data (part 
32, FCM #92). More recently the 
same idea was revisited (part 148, 
FCM #208) with the introduction of 
the “Crop Image to Clip” option in 
the context menu for bitmap 
images. In this case, it’s not so much 
that the image isn’t included more 
than once, but rather that most of 
the unused parts are thrown away, 
resulting in separate embedded 
images that may require less 
storage space in the SVG file. This 
feature was added in Inkscape 1.3, 
but it was far from being the 
headline addition for that version.

The most lauded change in 
Inkscape 1.3 was probably the 
addition of the Shape Builder tool, 
which I covered in part 137 of this 
series (FCM #197). If you’re not 
familiar with this tool, then I 
recommend reading that article 
before continuing with this one. As 
I described it there, “the Shape 

Builder can be thought of as a 
convenient way to perform certain 
Boolean operations between 
objects,” which hints at its biggest 
limitation: it only works with vector 
objects. Until now.

As of version 1.4, it works with 
bitmap images too. Which gives us 
yet another way to chop up La 
Giaconda into smaller parts that can 
be freely rearranged. As before, I 
plan to isolate her head and hands, 
so the first step is to drop my 
bitmap image into Inkscape and 
draw some shapes marking the 
areas of the picture that I want to 
keep.

In the 2014 version of this 
technique I’d now be faced with 
grouping the image, then entering 
the group to clone it, copy the 
clone to the clipboard, exit the 
group, paste the clone, and use the 
two ellipses as clipping paths. It 
does the job well, but requires 
several steps and too much 
understanding about the structure 
you’re ultimately making in the SVG 
file.

The 2024 approach, with 
Inkscape 1.3 or later, is a little 
simpler. Rather than creating 
complex arrangements of groups 
and clones, you just duplicate the 
image (Ctrl-D) until you have as 
many copies as you have shapes to 
clip with. Each copy is then clipped 
with one of the shapes – so in this 
case I will duplicate once, and clip 
twice. Selecting one of those 
clipped versions shows a bounding 
box that makes it clear that the 
entire image is still present – so all 
you’ve done so far is drastically 
increase the size of your file, due to 
that duplication.

The last step, however, is to 
right-click on each clipped image 
and select “Crop Image to Clip”. 
This throws away much of the 
image content, such that the 
bounding boxes are now only as 
large as they need to be, and the 
status bar will show that the image 
dimensions have reduced.
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But this is 2025 and Inkscape 1.4 
gives us a new approach that is 
simpler to apply than both of these. 
The result will be conceptually 
closer to the first, but the simplicity 
alone probably makes this the 
preferred approach in most cases. 
The steps are as follows:
•  Prepare the bitmap image and 
clipping shapes as before.
•  Select all of the objects.
•  Switch to the Shape Builder tool 
(default keyboard shortcut: X).
•  Click within each of the clipping 
shapes so that they are shown with 
a blue translucent fill (see image 
below).
•  Press Enter, or click on the Accept 
button in the tool control bar.

What you’re left with is similar to 
the 2014 approach – clipped clones 
of the original image. But whereas 
the older approach left the original 
on the canvas (inside a group), this 
method moves the original bitmap 
data into the <defs> section of the 
SVG content – basically a part of the 
file that is used to store resources 
that are required to draw your 
design (such as gradient and filter 
definitions), but which do not 
directly appear on the canvas.

Because the original image is no 
longer present on the canvas, you 
can’t select it in order to clone it 
again should you need to create 
another clipped shape – perhaps 
focusing on the eyes or the mouth, 
for example. At first this might 
seem like a bit of a limitation of this 
approach compared with the older 
method, but there is a very simple 
workaround that renders it a non-
issue.

If you require another clone of 
the image, just duplicate (or copy 
and paste) one of your existing 
clipped shapes, then release the clip 
either via the context menu or the 
Object > Clip > Release Clip menu 
entry. This will leave you with a 
clone of the image from the <defs> 

section, plus a copy of your clipping 
path, which you can then delete or 
edit as necessary. Don’t be 
surprised if the clipping path looks a 
little different to your original – 
Inkscape throws away the style data 
when the path is used for clipping 
in this way, as it’s no longer 
necessary. What you’ll see, 
therefore, is the default SVG 
rendering of a path with unset fill 
and stroke – which appears as 
though it’s got a black fill.

Of course you’re free to set it 
back to whatever fill and stroke you 
prefer for your clipping paths 
(that’d be transparent fill and bright 
green stroke, for me) if you want to 
reuse the path rather than deleting 
it. Note that if you clip “normally” 
rather than using the Shape Builder, 
Inkscape preserves the style 
information for the path. It’s only 
the path shape data that is relevant 
for clipping, so whether the style of 
a clipping path is conserved or not 
is irrelevant for your final design.

In the event that you change 
your mind entirely you can, of 
course, undo the Shape Builder 
operation to return to the original 
situation of having the image 
directly on the canvas and no longer 
in <defs>. But what if you’ve saved 

and reloaded, such that you can’t 
undo back to that step any more, or 
you’ve made other edits since then 
that you don’t want to undo? 
Releasing one of your clipped 
shapes will, as above, get you a 
clone of the image plus the clipping 
path. Selecting the clone and using 
the Edit > Clone > Unlink Clone 
menu entry will turn the clone back 
into a real image on the canvas. But 
beware! This does not remove the 
image from the <defs> section, so 
you now have two copies of the 
image data in your SVG file, 
bloating its size. Assuming nothing 
else is using the <defs> version (i.e. 
you’ve removed all the clones from 
your document), you can use File > 
Clean Up Document to clear out any 
unused entries in the <defs> 
section, including the image data.

When using the Shape Builder 
with a bitmap image, it’s also 
extremely easy to create an ‘inverse 
clip’. We’ve looked at how to clip 
the image to leave only the areas 
enclosed by paths, but it’s just as 
easy to remove only those areas 
instead. Consider, for example, 
creating a version of the image with 
the face punched out (so to speak). 
For this, the steps are very similar 
to the earlier ones:
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•  Prepare the bitmap image and 
clipping shape.
•  Select all of the objects.
•  Switch to the Shape Builder tool 
(default keyboard shortcut: X).
•  Click on the image, outside of the 
clipping shape.
•  Press Enter, or click on the Accept 
button in the tool control bar.

Perhaps what’s most interesting 
here is the clipping path that’s 
being used. It’s no longer the path 
you originally drew, but rather a 
complex path which covers the 
image and has a hole in it that 
corresponds to your original 
clipping path. In other words, an 
‘inverse’ clipping path. Release the 
clip to see it in all its unset fill glory.

Creating an inverse clipping path 
has historically required manual 
work with Boolean operations. 

More recently, Inkscape has had a 
direct means to achieve this via 
Object > Clip > Set Inverse Clip (LPE) 
but, as the name suggests, this uses 
a Live Path Effect rather than just 
creating a suitable inverse path. It 
also doesn’t work on bitmap 
images, so it’s a non-starter in this 
specific case. The Shape Builder 
approach is much, much simpler 
than trying to create a suitable 
inverse path yourself, so it’s 
definitely the approach I will use in 
future.

If you do want your original, non-
inverse, path back when you release 
the clip, just select the inverse 
clipping path, use Path > Break 
Apart, and remove the outer part.

Although this specific example 
results in a complex clipping mask, 
that won’t always be the case. For 
disjointed areas, the Shape Builder 
will more commonly produce 

separate clipping paths – as in the 
case of the separate ellipses for 
face and hands at the start of this 
article. Consider these two uses of 
the Shape Builder:

The top design results in a single 
complex clipping path consisting of 
an inner and an outer loop. The 
bottom design results in two 
clipping paths: one simple path for 
the eyes, and a complex path for 

the outer section. Each of the 
resultant shapes in the bottom 
design can be moved 
independently, which may not 
necessarily be what you want.

If you do need to keep several 
parts relatively positioned after 
clipping, I strongly advise grouping 
them immediately after the Shape 
Builder has done its thing. It is 
possible to unclip them all, use Path 

> Combine to turn all the clipping 
paths into a single complex path, 
remove the excess clones and then 
re-clip a single remaining clone to 
create the same visible result with 
just a single clipping path – but 
there are very few cases where 
such extra effort would be 
warranted.

Will the Shape Builder be the 
last word in techniques for 
chopping up bitmap images into 
smaller parts? Only time will tell. 
But it’s definitely easier and more 
intuitive than the older approaches, 
so it will be my preferred approach 
for such work – for the time being, 
at least.

Image Credits
“La Gioconda” (aka “Mona Lisa”) by 
Leonardo da Vinci
http://en.wikipedia.org/wiki/
File:Mona_Lisa,_by_Leonardo_da_V
inci,_from_C2RMF_retouched.jpg

Mark uses Inkscape to create comics 
for the web (www.peppertop.com/) 
as well as for print. You can follow 
him on Twitter for more comic and 
Inkscape content: 
@PeppertopComics

https://www.peppertop.com
http://en.wikipedia.org/wiki/File:Mona_Lisa,_by_Leonardo_da_Vinci,_from_C2RMF_retouched.jpg
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Let’s begin this month by talking 
about grids. These are a feature 

that I rarely use, but there’s no 
denying that they can be invaluable 
when trying to keep objects neatly 
aligned – such as when using 
Inkscape as a makeshift DTP 
program in which you want text 
boxes to live on an underlying 
structure, defined with a 
rectangular grid. Some artistic or 
engineering work can also make 
heavy use of grids, particularly if 
you’re using an axonometric grid to 
create lines using an isometric (30°) 
or oblique (45°) projection.

Rectangular and axonometric 
grids have been part of Inkscape for 
a long time, but version 1.4 adds a 

third: modular grids. These share 
some similarity with rectangular 
grids, in that they are based on 
horizontal and vertical lines. But 
whereas rectangular grids use lines 
that extend to infinity to mark out 
squares and rectangles in the page, 
modular grids instead use an 
infinite array of rectangular blocks, 
with optional spacing between 
them.

For any new Inkscape users, it’s 
worth pointing out exactly how 
grids work. They’re purely a 
construction aid, and do not appear 
in exported or printed output from 
the program. Most commonly 
they’re used in conjunction with 
snapping, causing the cursor to 

snap to grid lines and intersections 
as you draw shapes on the canvas. 
Pressing the ‘#’ key will toggle the 
visibility of all the grids at once, and 
when they’re not visible then they 
can’t be snapped to. This makes it 
easy to use grids for general layout, 
but to turn them off quickly if you 
need to draw something off the 
grid lines without turning off 
snapping in general.

Creating grids has been made 
slightly easier in 1.4. They still live in 
the Grids tab inside the File > 
Document Properties dialog, but 
the previous approach of picking 
the grid type from a popup menu 
and then having to click the New 
button has been streamlined into 

direct creation buttons for each 
type of grid. You can still create 
multiple grids, mixing the types and 
parameters as you see fit, with each 
of them appearing as a separate 
tab in the lower part of the dialog.

It can be useful to have multiple 
grids active at once if you carefully 
tweak the parameters to create 
some kind of relationship between 
them. For example, here’s a 
modular grid (red) and axonometric 
grid (blue), adjusted so that the 
modular grid creates a series of 
‘frames’ inside of which the 
axonometric grid could be used to 
draw isometric designs. Consider 
something like a sprite sheet for an 
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isometric game, or trying to design 
a coherent set of icons with a faux-
3D effect, to see where such a 
capability could be useful.

But it can also be useful to 
create multiple grids that may not 
be so obviously related to each 
other. Usually in this situation you’ll 
use the fact that each grid has its 
own ‘Visible’ checkbox to turn them 
on and off without having to 
remove any of them completely. 
Unfortunately there’s no keyboard 
shortcut to make toggling 
individual grids easier, so if you do 
want to use multiple grids like this, 
you’ll be making frequent trips to 
the tabs in this dialog to turn each 
one on and off.

I covered rectangular and 
axonometric grids a decade ago, in 
FCM #97, and not a great deal has 
changed about their configuration 
since then. All the grid types now 
feature the ‘Align to page’ buttons – 
an array of 9 icon buttons that just 
act as shortcuts for setting the 
Origin X and Origin Y fields to some 
common values. But otherwise the 
controls for configuring rectangular 
grids remain largely identical.

Axonometric grids, on the other 
hand, have gained one other 
convenience feature with 1.4. Next 
to the Angle X and Angle Y fields is 
a button to open a small door-
hanger dialog. This contains a single 
field in which you can put a 
width:height ratio from which the 
angles will be calculated. This just 
saves you performing a little 
trigonometry if you know the ratio 
you want. For example, putting a 
value of “2:1” into this field results 
in the angles being set to 
26.565051°. I’m sure you’ll agree 
that, for most people, entering the 
ratio would be preferable to 
calculating the angles for yourself. 
Few people are likely to use this 
feature, though, as for the most 
common angles of 30° or 45° it’s still 
easier to type them into the fields 
directly as degrees. “1.73205 :1” 

and “1:1” would be the equivalent 
ratios if you really want to know.

Although little has changed 
regarding rectangular and 
axonometric grids, the star of the 
1.4 grid party is, of course, the 
modular grid, so let’s take a look at 
the parameters for those.

I’m sure you can work out what 
the Grid Units control does. The two 
Origin fields set the position of the 
top-left corner of the grid. You 
might expect values of 0 to result in 
a block being positioned so that its 
top-left corner is perfectly aligned 

with the top-left corner of the 
page, but that’s not the case due to 
the Gap values. These fields set the 
distance between blocks, but 
they’re dished out equally on 
opposite sides of the block: a Gap X 
of 10 mm will result in a space of 5 
mm to both the left and the right of 
each block, and similar logic applies 
to Gap Y. So if you do want your 
first block to be right in the corner 
of the page, you’ll need to set the 
Origin values to a negative value of 
half the corresponding Gap field. In 
other words, with a Gap X of 10 mm 
you need to set Origin X to -5 mm 
(and the same for the Y values). In 
most cases, however, a bit of a 
space between the page border 
and the grid is desirable, so leaving 
the origin values at zero might be 
fine. As usual, the exact parameters 
you need will be highly dependent 
on what you’re drawing, and how 
your image relates to the 
underlying grid.

The Block Width and Block 
Height fields are pretty self-
explanatory, other than the fact 
that it seems to be impossible to 
set them to nice, round, equal 
numbers. Having entered “40” into 
each field, you can see from the 
screenshot that one has been 
nudged slightly up, and the other 
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slightly down. Similar discrepancies 
seem to happen regardless of the 
Grid Units, so it’s not just a problem 
with some internal conversion from 
millimetres to pixels. The 
differences are tiny, and unlikely to 
cause a genuine problem for 
anyone – but it is rather annoying.

The Margin X and Margin Y fields 
set an offset that is used to draw a 
second block, centered on the first. 
This can be used to draw a margin 
box around each block, or to draw 
an inset box by using negative 
values. The margin boxes are drawn 
in the color set by the Minor Grid 
Line Color field, while the main 

block uses the corresponding Major 
Grid Line Color. In this screenshot, 
I’ve set the Minor Color to solid red, 
and the Major Color to solid blue – 
you can see how different margin 
values result in different minor 
boxes. Both major and minor blocks 
can be snapped to, so careful use of 
these fields might provide you with 
some useful snap points without 
requiring an additional grid to be 
created (though that’s still an 
option, of course).

I think the new modular grid 
type is a great addition to Inkscape, 
but it’s a little limited by the lack of 
some convenience features similar 

to the new Aspect Ratio option for 
axonometric grids. I’d love to be 
able to define a modular grid by 
telling Inkscape that I want each 
block to be 40 mm × 30 mm, and 
have it work out the Gap values 
required to fit as many blocks as 
possible onto the page, neatly 
centered. Or, conversely, set the 
gap value and number of blocks on 
the page, and have Inkscape work 
out the block dimensions.

Moving on from grids, there 
have been some small updates to a 
couple of the Live Path Effects 
(LPEs). First of all, the Ruler LPE has 
gained three extra parameters: 
Mark Angle, Minor Mark Gap, and 
Major Mark Gap:

The Mark Angle parameter 
allows you to create rulers in which 
the tick marks extend from the 
base path at an arbitrary angle, 
rather than always being 
perpendicular to it. The value is in 
degrees, and can be either positive 
or negative, depending on which 
way you want the marks to slant.

The Minor and Major Mark Gap 
fields let you offset the start of 
each tick some distance away from 
the base path. The value is a 
percentage of the overall mark 
length, but the mark is also 
shortened by this amount such that 
its end point remains the same. This 
means that if you want to shift the 
marks away from the base path 
while retaining their length, you’ll 
need to adjust the Major Length 
and/or Minor Length parameter as 
well.

This image (next page, top right) 
shows the result of using the 
parameters from the screenshot 
above – a Mark Angle of 30°, and a 
Minor Mark Gap of 5.

Unfortunately, the Gap fields 
won’t accept negative values, so 
they can’t be used to shift the 
marks out of the opposite side of 
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the base path in order to produce 
an asymmetric design in which, say, 
the tick marks extend 1/3 of their 
length on one side, and 2/3 on the 
other. 

The only other LPE to have 
received an update worthy of the 
Inkscape 1.4 release notes is Taper 
Stroke. This adds a new option of 
‘Clamp’ for the Start Direction and 
End Direction parameters. These 
parameters determine whether the 
taper at each end veers towards 
one side or is centered, with the 
new option cutting the shape off 
squarely, with no taper at all. To 
that end I think the use of ‘Clamp’ 
as the option name is a bad one; 
‘None’ or ‘Square’ would have been 
more descriptive, while ‘Butt’ would 
have better mirrored the naming 
used in the Fill & Stroke dialog.

The following image shows a 
line without the LPE applied, then 
two copies which do have it. The 
second line has the Start Direction 
set to ‘Center’ and the End 
Direction set to ‘Left’. The last line 
uses ‘Clamp’ and ‘Right’. You can 
see that the ‘Clamp’ option 
drastically reduces the length of the 
line, cutting it off where the taper 
would usually begin, so you may 

need to create an artificially long 
base path if you want to use this 
option.

Next month we’ll continue 
exploring more of the changes that 
have been introduced in Inkscape 
1.4.

https://www.peppertop.com

